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Lesson 1.
Scheduled Offerings

After creating instructor-led/blended items, the next step is to
schedule them for a specific date, time, and location in order to track
learner registration. Scheduled offerings are an Instructor-led or

Blended Learning Item with a scheduled date and time.

OBJECTIVES

Upon completion of this lesson, you will be able to:

+ Define scheduled offering terminology
+ Create a scheduled offering

+ Describe the purpose of the main tabs within a scheduled offering

SCHEDULING OVERVIEW

Scheduling management is the process of creating scheduled
offerings for instructor-led/blended items or schedule blocks. This
course focuses on scheduling items within SATERN Learning.
Creating a scheduled offering places an instance of the item on the
calendar, allows resources to be associated with it, and allows
learners to be registered into it. Learners are registered into
scheduled offerings by the admin, their supervisor, or themselves.
The process also triggers email notifications that may be sent to
participants, supervisors, instructors, and contacts associated with

the offering.
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Scheduling Terminology

Table 1 presents some terms and definitions related to scheduling in
SATERN Learning.

Table 1: Scheduling Terms and Definitions

Term Definition
Scheduled An Instructor-led or Blended Learning Item with a scheduled
Offering date and time.
Schedule A schedule block prevents resources from being scheduled
Block into another offering during a given time. Schedule blocks are

often used to make learners and resources unavailable on the
learning calendar, such as when equipment is undergoing
maintenance, or a learner is out of the office for an extended
period of time.

Segment A block of instruction within a Scheduled Offering. Scheduled
Offerings must contain at least one Segment.

Class A group of learners who are tracked as a group and perhaps
complete a series of scheduled training requirements.

Resources: Assets that are assigned and reserved to a segment within a
scheduled offering.

Instructor A person who will instruct or facilitate a specific portion of the
scheduled offering.

Facility A building where training takes place (e.g., Headquarters).

Location A space or room within facility (e.g., a classroom, computer
lab).

Equipment Reusable training objects (e.g., VCR, TV, video cameras, or
LCD).

Materials Consumable training objects (e.g., notepads, markers, or
specific training guides).

Custom Resources not categorized above intended to track training

Resources cost (e.g., catering or parking fees).

ADDING ASCHEDULED OFFERING

When you add a new scheduled offering, you must select the item to
schedule and determine a start date and time. SATERN Learning
creates the segments of the scheduled offering using the information
from the Segments tab from the Related area of the selected item
record (Figure 1).
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Segments Description Duration  DelayStart  Location Type Actions Delete
Online Content [] Select All
=] Day1

[ Human Resources Planning and Analysis | | 6,00 ‘ | | | Classroom [CLASS | w | Equi [}

Copy To All

Substitutes

Figure 1: Delivery Data Tab: Item Record

Each scheduled offering is comprised of one or more segments. A
segment is a block of instruction within a scheduled offering that can
have resources assigned to it. Once the scheduled offering is
created, an authorized admin can change the segment defaults.

Like items, scheduled offerings are made available to learners via
catalogs. When a new scheduled offering is created the admin has
the option to publish the new scheduled offering to all associated
catalogs. You may remove scheduled offerings from certain catalogs,
thereby making specific scheduled offerings available to some
learners but not others; however, a scheduled offering cannot be
added to a catalog that the item is not in.

You can add scheduled offerings from four locations:

+ From Welcome page, click the Add Scheduled Offering quick link

wig - Note: To access the Welcome page and quick links, navigate to Admin >
Home, or click the View Welcome Page icon in the Bookmarks section.

+ Type Add Scheduled Offering into Search field below the
button bar and click Go

+ Item record (click the Schedule link in the Actions area)

+ Navigate to Learning > Scheduled Offerings and click the Add

New link
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All four locations run a tool that provides a wizard interface, a

schedule preview, and a resource usage view for scheduling items

(or activities) (Figure 2).

Add New Scheduled Offering Help

|
i
! * = Required Fields
|

1. Summary Information
Description:

| “Type: @ item © Activi
! ype: % item ©) Activity * Domain: @ pusLc

I * ltem Type: -
| Catalogs: [] Publish in all associated catalogs
* ltem ID: Q@ i
Catalogs may be individualty removed from the
Scheduled Offering.
1. Schedule Information 3. Resources
* Start Date: | Facility: I @
(MM/DDIYYYY) =
Primary Location: ML+)
* Start Time:
(hhzmm AM/PM) Primary Instructor: @
* Time Zone: Eastem Standard Time (EST) - Equipment: -

Resource Usage View: Instructer ~ -]

= X

Figure 2: Add New Scheduled Offering Wizard

From this tool, you may set the default schedule information and
select the default Primary Instructor, Primary Location, and
equipment resources for all segments of the scheduled offering. The
schedule preview and a resource usage view show possible

resource conflicts.

Start Dates, Start Times, and Time Zones

When scheduling an item, you must specify a start date, start time,

and time zone of delivery.

Scheduling Management Page 5



SATERN

After you have entered all required information, click Preview to view

the basic scheduling information for the offering (Figure 3).

— 2. S5chedule Information

* Start Date: [ joansr011

(MMDDAYYYY)
* §tart Time: 10:00 am
{hnum AMPHM)
* Time fone: | Eastern Standard Time (AmericalMew E

Schedule Date/Time
Schedule
BA5F2011 08:00 Adn - 12:00 Pad
SO1572011 01:00 Pan - 05:00 P,

Figure 3: Schedule Information for New Scheduled Offering

Once the Scheduled Offering has been created, you may also decide
to enable the Use Time Zone of this Offering option. If you want
the start and end times of each segment to be displayed in the
selected time zone, click View All from the core area to open the
Additional Settings page. Scroll down to the Physical Schedule
section. The default is set to yes from the Use Time Zone of this
Offering drop-down menu. This is useful if learners are attending the

offering from different time zones (Figure 4).
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Additional Settings [l
*Reauiced Flslés
*Time Zone: Pacific Standard Time (Americallos Ange Registration Statun: I of 15 enrolled, 0 waitiisted =
Extended Summary
Active: Te *Contact:
" Emall:
Commaents:
*Training Vendor (ORG ID): *Source of Tralning: 01 (Hon-government)
“Direct Cost Code: 0 “indirect Cost Code: 0 {No indirect Cosy)
PO Humber: Funding Organtzation:  HAD
POC:  Barbara Chenler Budget Line ltem: 12
Physical Schedule
| Use Time Zone of this Offering:  Yes I Location: HZa1, RM. 147 MTG. RM.

Figure 4: Scheduled Offering Time Zone Setting

If this option is set to No, then all times will be recalculated and
displayed to the admin/learners in their preferred time zone.

witg - Note: The admin should set this option to No for Virtual Learning System
(VLS) scheduled offerings, as it will be beneficial for everyone to see the
times in his/her own time zones.

Note the Always display Scheduled Offerings in this Time Zone
checkbox, located under Preferences on the admin records and
under Options and Settings of the learner records, will override the
selection within the Use Time Zone of this Offering drop-down
menu within the scheduled offering record. This means that an
admin or learner will see all scheduled offerings in his/her own time

zone — regardless of the setting for a particular scheduled offering.

Resources

The primary purpose of the Resources area (Figure 5) is to allow you
to identify any of the listed resources (Facility, Primary Location,

Primary Instructor, Equipment) required for the scheduled offering.
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-3. Resources

Facility: | New York Office (NY) =] &

Primary Location: | New York Classroom 01 (CLASS-NY-01| ~ | €3

Primary Instructor: @, JEDADAMS

Equipment: | Overhead Projector (OVERT) B3]

Resource Usage View: |Location || &

Scheduled Offering
BL2402011 0800 Afh - 0Z:00 Pan, Excelling at Customer
Service

Simulation(3924)

Figure 5: Identify Resources for New Scheduled Offering

If the facility, Primary location, Primary instructor, or equipment that
you wish to attach to the scheduled offering does not already exist in
system, then you can add it directly from the wizard interface. This is
done by clicking the Add icon (@J) next to the respective resource
field (Figure 6). The ability to add from the wizard is controlled by

workflows.

-3. Resources

Facility: | Mew York Office (NY) =]

Primary Location: | New York Classroom 01 (CLASS-Nv-01| ~ | €3

Primary Instructor: @, |JEDADAMS

Equipment: | Overhead Projector (OVERT) B3]

Resource Usage View: |Location |»| &

Figure 6: Add New Resources
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After you enter all required information and associate the scheduled
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offering with at least one resource, select that resource from the
Resource Usage View drop-down menu (Figure 7). The system
shows all of the other scheduled offerings that also use the resource
selected. If nothing is displayed, then the resource you selected is
not being used by any other scheduled offering.

—3. Resources

Facility: | Mew York Office (NY) B+

Primary Location: | New York Classroom 01 (CLASS-NY-01| ~ | €3

Primary Instructor: @, |JEDADAMS

Equipment: | Overhead Projector (OVER) B+

Resource Usage View: |Locston |v| &

Figure 7: View Resource Usage
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Lab 1.Add New Scheduled Offering

Step
1. Verify the Admin tab is selected.

2. Access the Add New Scheduled Offering wizard in one of the
fours ways described in the previous section.

3. Select the Item type radio button.

4. Click the Item ID magnifying glass icon to search for the item to
schedule (depending on the method you selected in Step 2, this
information may be prefilled).

5. Enter a description for this scheduled offering.
6. Specify a domain for the new record.

7. Check the Publish in all associated catalogs checkbox.

wiitg  Note: If you select the Publish in all associated catalogs checkbox,
then (when you save the new scheduled offering) the system
automatically adds this new scheduled offering to every catalog that the
item already belongs to. This makes it visible and possibly available for learners to
self register.

8. Select a start date, start time, and time zone.

wiitg - Note: The scheduled start date and time and the scheduled end date and
time will appear below the schedule information.

9. Optional: Click Preview to view the basic information for the
offering.

10. Select a facility from the Facility drop-down menu.

11.1f applicable, select the other resources associated with the

scheduled offering: Primary location, Primary instructor, and

equipment.

uiyg  Note: Alerts are displayed if there are any resource conflicts. Depending
on the item configuration, an alert may also display if the selected
instructor is not authorized to teach the item.

Scheduling Management Page 10
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12.Click Save.

13.1f there are any warnings, the Warning Details screen displays.
Click Yes to continue.

14.The scheduled offering record displays allowing you to make
further configurations.

15.For use in future labs, record the system generated scheduled

offering ID (numeric value located in the upper right corner of the
core area).

(1 Job Aid: Create Scheduled Offering

Scheduling Management Page 11
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SCHEDULED OFFERING RECORD: MAIN AREAS

The scheduled offering record is divided into three main areas
(Figure 7):

—=N

+ Core (outlined in red at the top left)
+ Related (outlined in yellow at the bottom half)

+ Actions (outlined in green at the top right)

Sgarcht | Enter Keywords or Command | Gatk k-3
(= BUSINESS WRITING WORKSHOP 579% [
Description:
[bme WORKSHOP ARC-TIGIEWW {Hev 871... Approval Process:  Supmrviur Toainimg Office Somcisl
Approval Required: Yoo “Domain:  Ames Research Center [ARC)
End Date: 4/1%/2012 End Time: 0%:30 Am
*Facility: ARC BLDG. HI41 (ARCHI41) Imstruetor: Mo Hame
Start Date: 4/16/2012 Start Time: 01:00 PM
*Time Zone: Pacific Standard Tine (Amerca/lc Registration Status: 2 of 15 enolled, 0 waitlisted
View All &
. ’
3 %
Related More @ Registration  Add Learnerss | || Settey | | advane oa | &
Catalogs

5 STAHLEY 5 TP

B oo B e

Figure 8: Scheduled Offering Record

These areas contain fundamental information regarding the
scheduled offering. Some areas may be inaccessible (grayed out)
depending on your role as an administrator within the system. .

This portion of the guide focuses on the most commonly used
scheduled offering record areas, specifically the core area, and the
Registration, Catalogs, and Segments tabs from the Related area,
and describes some of the attributes found within these areas.

Scheduling Management Page 12
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Core Area: Summary

You can use the core area of the selected scheduled offering record
to update the basic attributes of the record (summary information).
These attributes could include, for example, the offering description,
domain, facility, registration settings, and any other fields deemed
required by the global system administrators or added based on your
Personalize Fields preferences (Figure 9).

= Company Benefits Orientation B8 [E @
Company Benefits Orentation
Item: COURSE HR-101 (Rev 5/14/2003 ... Approval Process:
Approval Required: Mo *Domain: Default Public 4ccess Domain |

End Date: 10/26/2011 End Time: 05:00 Pii

Facility: Mew York Office (NY] Instructor: No Name

Start Date: 10/26/2011 Start Time: 02:00 &AM

*Time Ione: Eastern Standard Time (Amer Registration Status: © of 25 enrolled, 0 waitlisted
Yiew all @

Figure 9: Scheduled Offering > Core Area

Click Yiew Al ® 15 see additional settings for the scheduled offering,
including title, description, summary, extended summary, physical
schedule, and registration.

Table 2 provides the comprehensive list of fields that may be found
within the scheduled offering record, a description of each field, and
whether the field is displayed to learner.

Table 2: Scheduled Offering Record: Fields and Descriptions

Display
Field Description s to
Learner
Description Additional information about the scheduled offering X
for leaners.
Domain Indicates admin ownership of the scheduled offering

(e.g., HR, IT, etc.).
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Facility

Time Zone

Approval
Process

Approval
Required

Contact

Email

Active

Enable
Learners to
Waitlist

Registration
Cut-Off
Date/Time

Time Zone

Published
Price

Self
Registration
Minimum
Registration

Maximum
Registration

Registration
Status

Email
confirmations
to

SA

Description

The building where the scheduled offering takes
place.

Indicates the time zone of the scheduled offering.

Indicates a default approval process (if applicable)
that a learner must complete before being able to
complete the self-registration process.

This checkbox triggers the approval process
entered in the Approval Process ID field.

The name of contact person for the scheduled
offering (can also be included in the registration
notification email).

Email address of the contact person of the
scheduled offering (can also be included in the
registration notification email).

This checkbox is used to indicate whether a
scheduled offering is active and displays in the
learner catalogs.

Selecting this checkbox indicates that the system
will allow learners to be waitlisted for this item. If
you select the Auto Fill Registration checkbox,
walitlisted learners automatically replace learners
who are withdrawn from the scheduled offering.

The last date and time when a learner can change
his/her registration status (e.qg., register or
withdraw).

The time zone of the Registration Cut-Off Time.

The internal price of the scheduled offering
(learners see catalog price).

Displays the Registration button to learners so they
can register for the scheduled offering.

The minimum number of learners needed to hold
the request schedule process. This information
carries over to the scheduled offering record.

The maximum number of learners allowed in the
scheduled offering. Check Enable Learners to
Waitlist for the system to place learners who exceed
the maximum on the waitlist.

The number of learners registered and waitlisted.

Select the corresponding check box to indicate to
whom email notifications should be sent in
reference to the selected scheduled offering.

Display
s to
Learner

X

X

=N
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Related Area

The Related area contains additional information regarding the
scheduled offering, including registration information, associated

catalogs, and segment details (Figure 10).

Related More @ Regittration  Add Lewmers: | ppe—— i
Catslogt Non-enrolled | Weltisted (%) =] Enrolled (2) | Total (15) = Open (1) | Siots
vegment Filze 4| | Sert By: Reghiration | v Filter for Encolled Laarner

- STANLEY ™ i

B s B voere

Figure 10: Related Area of Scheduled Offering Record

Managing Registrations
The Registration tab from the Related area (Figure 11) allows you to:

+ Register learners for the scheduled offering
+ Change learners’ registration status

+ Send emalil notifications to the learner, his/her supervisor, the

instructor, and the designated contacts

+ Add slots (seats for an organization) to the scheduled offering

Related More @ Registration  AddLeaners: |+ prv——
Catslogt Non-enrolled | Weltisted (%) =] Enrolled (2) | Total (15) = Open (1) | Siots
Sagiaoia Filter | | Sort By: Roghstration | w | [ Tiiter for Envolled Loarner

- STANLEY ™ i

B s B voere

Figure 11: Related Area of Scheduled Offering Record: Registration
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Associating Catalogs

The Catalogs tab from the Related area of the scheduled offering
record allows you to determine which learner and supervisors can
access the scheduled offering for self-registration. When an item-
based scheduled offering is created, it is added to the catalog or
catalogs in which the item is currently located.

You may decide not to permit learners or supervisors access to the
specific scheduled offering by removing all the catalogs from this tab.
It may be necessary to remove one or more catalogs from this tab to
restrict access to particular learners. If removed, a catalog may be
returned to this tab; however, a scheduled offering may never be
placed into a different catalog than that of the item on which it is
based (Figure 12).

Related More @ Catalogs \i’ Change Catalog Prices @ 2
Registration Description Price Remove
Segments Human Resources 200,00 U3 Dollar (U150 [

KS0 General 0,00 US Dallar (US0Y [

Figure 12: Related Area of Scheduled Offering Record: Catalogs
Viewing and Modifying Segment Details

Scheduled offerings are divided into segments primarily for purposes
of resource allocation (building scheduled breaks into the schedule is
the other). A scheduled offering must have at least one segment.
You can add additional segments or modify the date and time
information in existing segments (Figure 13), and add resources to
segments.

Note: Assigning resources is explained in more detail in the next lesson.
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Related More @ Segments | () Resend Registration Hotifications 8 'z

Reshtration | [T) ooy || 7] weeke | | 5] montn | G@ = 24-30 October 2011 By | [B] rodsy

Gatalogs Monday Tuesday Wednesday Thursday Friday Saturday Sunday
m 24 Gctober 25 26 27 28 29 30 COctober

06:00 AM

07:00 &AM

08:00 AM

fom00 AR =

BTN Session

10:00 AW | e
Instructor:
11nn amM e

Figure 13: Related Area of Scheduled Offering Record: Segments

When you modify a segment, the system displays the Save and
Cancel buttons. Click Save to save your changes or the system will
discard those changes when you access another part of the

application.

The calendar view is interactive and displays the day, week, and
month views of the schedule. You can easily edit segments by
dragging and dropping the segment details box to the new day and
time.

You can edit any of the segments for the scheduled offering in list or
calendar view, but you must use the list view to copy segments or
record attendance for a segment (Figure 14). Click the List View

icon ().

Segments @I || Resend Registration Hotifications @ 4
Description Primary Location Primary Instructor Actions Remove

[] Select AlL
[=] Wed 472772011
08:00 As - 12:00 PM Morning Session New Y ark Lasture H:s Atteidanice D
01:00 Ph4 - 05:00 PM Afternoon Session Mews Yark Lecture H... Attendance ]

Figure 14: Segments Tab of Related Area: List View

To copy segments, click the Copy Segments icon (*').
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To record attendance for a segment, click the Attendance link in the

—=N

Actions column to display the Record Attendance window (Figure
15). Click the checkbox in the Attendance column and enter any
comments as necessary. You can click Copy to Same Day
Segments to copy attendance information to all segments on the
same day. Click Apply Changes to save your modifications.

Record Attendance

Segment 1 - Morning
Learner ID Learner Name Attendance Comments
Sslect All/Dassiect A1

sastanley STANLEY, SYLVIA A

lcjacome ZIPP, LYNMETTE C

Apply Changes Cépy to Same Day Segments

Figure 15: Record Attendance
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LESSON-RELATED REPORTS

The following are reports in SATERN Learning that relate to this

lesson:

+ Scheduled Offering Data

The Scheduled Offering Data report returns detailed information
about each schedule offering including the item scheduled, dates
scheduled, registration and waitlist data, instructor data, segment
data, and delivery costs.

+ Learning Calendar

The Learning Calendar report returns all the daily learning events
scheduled within an entered date range.

CONCLUSION

In this lesson, you were introduced to the main scheduled offering
concepts, areas within the record, and the information contained on
each. Using the step-by-step instructions, you created a new
scheduled offering and entered key information.

You should now be able to:

+ Define scheduled offering terminology

+ Create a scheduled offering

+ Describe the purpose of the main areas (core, related, action)

within a scheduled offering

In the next lesson, you will learn how to work with scheduled offering

segments and resources.
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LESSON CHECK

Use what you learned in this lesson to answer the following

guestions.

1. True or false:

Learners, supervisors, and admins are the three groups that may

have the ability to register learners into scheduled offerings.

2. True or false:

An admin can be listed on the Contacts tab of a scheduled offering

record.

3. True or false:

A scheduled offering may never be placed into a different catalog
than that of the item on which it is based.

4. True or false:

If you want to display the start and end times of the segments of a
scheduled offering in a specific time zone, you should click yes in the
Use Time Zone of this Offering field.

5. A scheduled offering is:

An instance of an item placed on a learning calendar.
An assignable unit that a learner must complete.

A grouping of curricula.

a0 o w

None of the above.
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6. True or false:

A scheduled offering must contain a segment.

7. Define the term schedule block.
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Activity

Your boss has given you the following task:

+ Management has decided to offer Item X to the employees.

+ Your boss has told you it will be held two weeks from today from
9:00 AM — 5:00 PM.

+ She wants this scheduled offering to be viewable to all learners.

Use SATERN Learning to perform this task.
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Once you create a scheduled offering, you may need to update the
date/time and change resource allocation. This information is
managed through the Segments tab, from the Related area of the
scheduled offering record.

OBJECTIVES

Upon completion of this lesson, you will be able to:

+ Modify segments of a scheduled offering
+ Assign resources to a segment

+ Record attendance for a specific segment

SEGMENT MAIN CONCEPTS

A segment is a block of time within a scheduled offering primarily
used for resource allocation. If a learner is registered in a scheduled
offering, he/she is registered in all segments. Segments contain any
applicable resources (locations, equipment, instructors, etc.) needed
for the specified timeframe. Resource assignment to a segment is
optional, but each scheduled offering must have at least one

segment.

In SATERN, a scheduled offering is created using the default
segment structure from the Segments tab from the Related area of
the item record.

Scheduling Management Page 24



SAT

—=N

RESOURCES ASSIGNED TO SEGMENTS

A segment can have multiple resources of the same type (e.g., two
instructors) (Figure 16).

Edit Segment EII

*Required

FStart Date: | 10/26/2011 | [5] FStart Time: | 02:00 A
*End Date: | 10/26/2011 [ *End Time: I 12:00 Pad, |

*Time Fone: I Eastern Standard Time [(fmercalMew York) | = I

Description: I Morning Sezsion ]

Resources litj View suggested resource types | Apply to All Seg...
Type & Title Primary Remove
=Location
LEC - Hew York Lecture Hall 02 ® I
A structor
Jeffrey D Adams (= =
Rob C Belskey @) ™|

—_— WI cancet | | vetete |

Figure 16: Two Instructors for Segment

Once a resource is assigned to a segment, it is “booked,” and if
another admin attempts to schedule the resource during the same
timeframe, SATERN alerts him/her that there is a conflict. You can
view the conflict and take the appropriate steps to free up that
resource or find an alternative.

In order for you to assign a resource to a segment, the resource

record must already exist in the SATERN Learning database.
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Activity

Using an item that you would schedule, list the resources you will

need. How do you currently schedule and track these resources?
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ASSIGNING RESOURCES TOSEGMENTS

SATERN provides the ability to schedule resources for the specific
segments (times) in which they are needed instead of scheduling
them for an entire scheduled offering. When multiple resources of a
single type are associated with the segment, you have the ability to
identify the primary resource for each segment. The Add Resources
button enables you to assign equipment, materials, and custom
resources to a segment.

Assigning Instructors

Once the instructor is identified (i.e., exists in SATERN), he/she can
be assigned to the segment(s) within a scheduled offering.

Click Add Resources (-.@f' ) and select Add Instructor from the drop-
down menu (Figure 17).
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Edit Segment @.

#*Requirad

#Start Date: | 0/26/2011 | [E] FStart Time: | 08:00 A
*End Date: | 10/26/2011 [#  *End Time: | 12:00 Pin

*Time Fone: [ Easztern Standard Time [(fmericalMew York) v I

Description: | Morning Session l

Resources |G || View suggested resource types | Apply to All Seg...
Type & Titl: Add Location : Primary Remove
Location Add Equipment
Add Custom Resource
LEC - Hew ® =
=) Instructor
Jeffrey D Adams ® ™

T I IS

Figure 17: Segment - Add Instructor

SATERN returns all instructors in the search results. The search
results include a column that displays the resource availability, which
can help when determining the segment resource allocation (Figure
18):

+ Not Available

+ Available for entire scheduled offering

+ Auvailable for current segment

+ Blank (when segment information is not available)
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= Search Results

View Instructors Results

Records per Page |£5 Page: 1 2 3 B sPrewious Mexts (116 total records) Page |1 of 5. m
lect All

Instructor (D Instructor Marme Related User Awvailability
JEDADAMS hdams, Jeffrey D failable for Entire
Scheduled Offering
LUDALMEIDA Almeida, Luana D Ayailable for Entire [
Scheduled Offering
APDAMADOR tmador, April D fwailable for Entire [
Scheduled Offering
CHDAMCERSOMN Anderson, Chad D Available for Entire §
\ Scheduled Offering ‘

Figure 18: Instructor Search results

To perform a keyword search and select search filters, select the

Search tab. Enter your search criteria and click Search (Figure 19).

instructors &

Search

Results

\—Saacch lostoucidrs

Enter avalue far each field that you want to use to filker your search. Some fields allow you to select from a list of values,
You can also add or remove search criteria to further refine your search.

Case sensitive search: ) yes @ o

Instructor ID: | Starts With |Z| |

Last Name: | Starts With |Z| |

First Hame: | Starts With |Z| |

Middle Initial: [ starts with [=] |

Items: @ Type: @E i
1D: IHR-101

Add/Remove Criteria © m E

Figure 19: Keyword and Filter Search
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Assigning Locations

When you identify the training location, you can assign it to the
segment(s) within a scheduled offering (Figure 20).

Edit Segment @'

*Required

*Start Date: | 10/26/2011 |E| *Start Time: | 05:00 A
“End Date: | 10/2¢/2011 | [F]  *End Time: [ 12:00 P |

*Time Fone: \ Eastern Standard Time (fmercafMew York) | » I

Description: [ Morning Session l

Resources Q ¥ | View suggested resource types l Apply to All Seg...
Type & Title Primary Remove
E|L|J[:E|ti|3n
LEC - Hew York Lecture Hall 02 (= =

=nstructor
Jeffrey D Adams

Rob C Belskey oy had

—_— Wl cancet | | detete |

Figure 20: Segment — Primary Location

To assign locations to segments, click Add Resources ('.@fv') and
select Add Location from the drop-down menu. SATERN allows you
to search the database for locations that match the type of location
the item creator designated. Enter a location type if desired, or leave
it blank, and SATERN returns all locations in the search results
(Figure 21).
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Search

-

Search Locations

Enter a value for each field thatyou want to use to filter your search. Some fields allow you to select from a list ofvalues.
You can also add or remove search criteria to further refine your search.

Case sensitive search: I ves @ po

Location ID: Starts With |Z| |

Description: : Starts With |Z| |

Lacation Type: | starts with [=] [cLass ¥

Locations: ) Available for current segment ©) Available for Entire Scheduled Offering @ Al
Add/Remove Criteria © m @

Figure 21: Location Search Window

Assigning Equipment

Equipment is any reusable resource that is used in the delivery of
scheduled offerings. These include overhead projectors, television
monitors, classroom laptops, etc. Equipment can be associated with
locations and facilities. You may schedule equipment that does not
come with the location that has been scheduled. To schedule these
additional resources, click the Add Resources button for the

segment in which you want to schedule them (Figure 22).

Resources |23 "|

T:,rpe & Tit Add Location
Add Instructor

EIle:Eltiun | R Eqmen
CLASS - L[J Add Custom Resource

Figure 22: Add Equipment to Segment
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Resource Conflicts

If you select a resource that is already scheduled for the same time
in which you are trying to schedule it, a warning message displays.
You can view the conflict and make a decision to continue and
schedule that resource or search for and select another (Figure 23).

Confirm Warnings [
The resources below are already scheduled during the indicated segments: —
Segment & Resource Conflict Scheduled

=110/2642011 01:00 PM - 05:00 PM

= Jeffrey D Adams
Owerview to Effective Bu... 10/26/2011 08:30 AM - 0...
Figure 23: Resource Conflict Warning Message

Regardless of the view you are in (calendar view or list view), any
resource conflicts are indicated by the View Resource Conflicts

icon ( :'i\). Click this icon to view the conflicts.
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Lab 2.Assigning Resources to Segments
Step
1. Navigate to Learning > Scheduled Offerings.

2. Enter search criteria to search for and locate the scheduled
offering created in Lab 1.

3. Click Search.

4. Click the scheduled offering ID link to access the scheduled

offering in edit mode.
5. Select the Segments tab from the Related area.

6. In calendar view, double-click the segment in which you want to

assign resources to.

wiwig  Note: In list view, click the segment link.

7. For the selected segment, select a primary instructor:

a. Click Add Resources.

b. Select Add Instructor.

c. Click the corresponding checkbox to select the instructor to
add for the segment.

d. Click Add.

e. ldentify the primary instructor and click the corresponding
radio button in the Primary column.

f. Click Save.

sy Note: When searching for an instructor, the search screen defaults with
the item information entered as search criterion. If you do not remove this
criterion, SATERN returns only instructors who are authorized to teach this
item.

8. Select a primary location.

9. Click Save and Close.
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Note: If there are multiple segments and one or more of the segments do
not have a primary instructor and/or location designated, the system
displays a warning pop-up box. Click OK to continue.
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i1 Job Aid: Create Scheduled Offering
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APPLY TO ALL SEGMENTS

In the associated resources area, you can add all of the resources
that will be needed to deliver the segment. You can also click Apply
to All Segments to copy the resources which you have added to the
segment that you're modifying, to all other segments of the

scheduled offering (Figure 24).

Edit Segment @'

*Required

FStart Date: | 10/26/2011 | [5F] “Start Time: | DZ:00 A4
*End Date: [ 10/26/2011 | [E *End Time: | 12:00 pi |

#Time Fone: I Eastern Standard Time [(Amedcal/Mew York) |« I

Description: [ fibarning Seszion ]

Fesources (@) |»| View suggested resource types | Apply to All Seg...
Type & Title Primary Remove
1=l gcation
LEC - Mew York Lecture Hall 02 O] ™

Figure 24: Apply to All Segments

If you're editing an existing segment, then you can click View
suggested resource types to review the resources that are
identified on the item record (Learning > Items > Segments tab) for

the effective delivery of the scheduled offering.
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Lab 3.Adding a Second Instructor to a Segment

Step

1. Navigate to Learning > Scheduled Offerings.

2. Enter search criteria to search for and locate the scheduled
offering created in Lab 1 and click Search.

3. Click the scheduled offering ID link to access the scheduled
offering in edit mode.

4. Select the Segments tab from the Related area.

5. In calendar view, double-click the segment you want to add a

second instructor.

6. Click Add Resources and select Add Instructor from the drop-

down menu.

7. Click the corresponding checkbox to select the second instructor

to add for the segment.
8. Click Add.

9. Identify the Primary instructor and click the corresponding radio
button in the Primary column.

10.Click Save.

11.View all the instructors scheduled to teach during the segment.

Note the primary instructor.

12.Click Cancel to return to the calendar or list view.

Note: If you did not click Save (step 10), then in step 12, click Save and
Close (instead of Cancel) to save your changes and return to the segment

calendar or list view.

= Job Aid: Create Scheduled Offering
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ADDITIONAL SEGMENTS

Once a scheduled offering is created, you have the ability to add or
remove segments from that scheduled offering. The default segment

structure is established through the Segments tab of the item record.

You can add a new segment to the scheduled offering by either
clicking the Add New Segments button (Figure 25) or by clicking the
Copy Segments icon (Figure 26). The Copy Segments icon is only

available in list view.

Related More @ Segments ﬁ
Registration I m Day ‘ l m T I I @ T ‘ @
Catalogs Monday Tuesday
12:00 &AM
01:00 &M

Figure 25: Add New Segment to the Scheduled Offering

Related More & Segments | O
Registration Description
Catalogs
1 wed 10/267201
/b, DB:00 AM - 1 288=Piidorning Session

01:00 PM - 05:00 PM Afternoon Session

Figure 26: Copy Daily Segments
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Lab 4.Adding Segments to a Scheduled Offering

Add a New Segment

Step

1. Navigate to Learning > Scheduled Offerings.

N

Enter search criteria to search for and locate the scheduled

offering created in Lab 1.
3. Click Search.

4. Click the scheduled offering ID link to access the scheduled
offering in edit mode.

5. Select the Segments tab from the Related area.
6. Click the Add New Segments button.
7. Enter the segment information:

a. Start date and time
b. End date and time

c. Segment description (optional but recommended)

8. Click Add Resources to add instructors, locations, etc.

9. Click Save to save your changes and continue to modify the
segment details, or click Save and Close to return to the
Segments tab.

Copy Daily Segments

Step

1. Navigate to the segment you just created.
2. Click the List View icon.

3. Next to the segment just created, click the Copy Segments icon.
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4. Enter the number of times to copy the segment.
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wiig  Note: The system is actually copying all segments scheduled on the same
date of the segment you selected, not just the segment you selected. This
will create each duplicate segment(s) on a different day. You can modify
the new segment dates, times, and time zones once they are created.

5. Click Copy.

6. View the new segment(s).

sy Note: The resources assigned to the original segment are carried over to
the new segment(s).

7. Modify the description for each new segment.
8. Click Save and Close.
9. Change the end time of one of the new segments.

10.Click Save and Close.

[, ~Job Aid: Create Scheduled Offering
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RECORD ATTENDANCE

Click the Attendance link in the Actions column for any segment of
the scheduled offering. The Record Attendance window displays
enabling you to record a learner's attendance for that segment
(Figure 27).

sy Note: To include attendees who were not already enrolled, the attendee
names must be entered in the registration tab, before recording
attendance.

Record Attendance

Segment 9 - Default segment
User D User Mame Aftendance Comments

Select All/Deselect All

JEDADAMS #dams, Jeffrey D & |
ERAFAHEY Fahey, Brian & E !
DOARARILLS ills, Dord M [Fl [

Apply Changes ! Copy to Same Day Segments

Figure 27: Record Attendance for Each Segment

Record the learner’s attendance by clicking the checkbox in the
Attendance column. You can enter any comments for each learner

as well. Click Apply Changes to save your record.

If the scheduled offering has multiple segments, click Copy to Same
Day Segments to copy the attendance record and any comments for
all learners from the current segment to all segments that start on the

same day.

sy Note: Recording segment attendance is for administrative use only. The
system does not store this attendance with the learner’s learning history.
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LESSON-RELATED REPORTS

The following report in SATERN relates to this lesson:

+ Scheduled Offering Data

The Scheduled Offering Data report returns detailed information
about each scheduled offering including the item scheduled, dates
scheduled, registration and waitlist data, instructor data, segment
data, and delivery costs.
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CONCLUSION

In this lesson, you were introduced to key segment concepts,
including assigning resources and adding additional segments to a
scheduled offering. Using step-by-step instructions, you assigned
instructors and locations to segments and added new segments to a

scheduled offering.

You should now be able to:

+ Modify segments of a scheduled offering
+ Assign resources to a segment

+ Record attendance for a specific segment

In the next lesson, you will learn how to set registration parameters

and register learners for scheduled offerings.
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LESSON CHECK

Use what you learned in this lesson to answer the following
guestions.

1. You have just become aware that the scheduled offering times
and location have changed. What steps should you take to make
the changes and inform all concerned parties?

2. List three types of resources that can be assigned to a segment:

3. True or false:

If you receive a conflict-warning message, you cannot schedule that
resource for that specific time.
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NOTES
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Lesson3: Registration

Now that the scheduled offering is configured, you can register
learners. In this lesson, you will learn the registration process to

register learners for scheduled offerings.

OBJECTIVES

Upon completion of this lesson, you will be able to:

+ Define the six registration statuses

Set the registration parameters for a scheduled offering

*

+ Register learners for a scheduled offering
+ Use the Registration Assistant Tool
+ Define and reserve slots for a scheduled offering

+ Cancel a scheduled offering

REGISTRATION MAIN CONCEPTS

How a learner registers for a scheduled offering is determined on an
offering-by-offering basis. If configured, learners may self register for
scheduled offerings. Supervisors may also be given the ability to
register subordinates. Otherwise, administrators must register
learners in scheduled offerings. When learners are officially
registered and have a status of Enrolled, the system is capable of
generating email notifications and sending them to the learner,
his/her immediate supervisor, the instructor, and any other contact
associated with the offering; if the corresponding checkboxes are

selected at the time of registering the learner.
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A learner may have one of following SATERN defined registration

statuses:

+ Enrolled: The learner has a seat in the scheduled offering.

+ Waitlisted: The learner is waiting for a seat to open. (If Auto Fill
Registration is checked, SATERN automatically registers a
waitlisted learner when another learner cancels/withdraws.
SATERN prioritizes the waitlist as first one on the waitlist is the

first registered into the offering.)
¢+ Cancelled: The learner does not have a seat.

+ Pending: System assigned for learners “pending” approval in a
SATERN defined approval process.

¢+ No-Show: In instances where a learner does not show up for
training, the administrator needs to indicate this in SATERN since
SATERN cannot know if the learner attended the training.

+ Walk-In: Ininstances where a learner does not register in
SATERN prior to the start of the training, but goes to the training

and attends.

NASA Business Rule

If a learner does not show up for training, administrators shall change
the learner’s registration status from Enroll to No Show on the
registration section of the scheduled offering prior to recording the
learning event. This takes the learner off the roster for the scheduled
offering and does not record a training completion to the learner’s
history.

REGISTRATION DETAILS

If a scheduled offering is made available for learner self-registration,
an approval process may be specified. If so, the learner is registered
with a Pending status until the approver(s) have allowed registration

to continue. (See Multi-level Approvals guide). If approval is required,
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indicate in the core area which approval process should be used

|1

(select from the Approval Process drop-down menu) and if
approval is required (select from Approval Required drop-down

menu) (Figure 28).

™ KSC LEAP VI-MODULE 6: WORKFORCE PLANNING & INFORMATIO... 5079 [E @ @

Desediption:
KSC LEAR WI-MODULE 6: WORKFORCE PLAMNING &
INFORMATION SYSTEMS

Item: COURSE KSC-LEAP-VI-M6 (... Approval Process:  Supendsori/Training Off

Approval Required: “es *Domain:  fennedy Space Center |

Figure 28: Core Area: Approval Required

Click View All to display the Additional Settings window and scroll
down to the Registration section to see the registration details for

the scheduled offering (Figure 29).

Registration
ail confirmation to the Instructor: Mo Email confirmation to the Supervisor: Mo

Email confirmation to the Learner: No Email confirmation to the Contacts: Mo

Enable Learners to Waitlist:
Minimum Registration:
Registration Cut-off Time:

Published Price:

5 Registration Cut-off Date:

Registration Cut-off Time Zone:

0.00 US Dollar [USD] [Default]

Figure 29: Scheduled Offering Registration Details

Self Registration:

Maximum Registration: 50

MDD

Yes

Set the Auto Fill Registration option to Yes to enable the system to

automatically select and register the next learner on the waitlist

should a registered learner withdraw (or be removed or cancelled by

an admin). The learner who is listed first on the waitlist is registered

first.

If learner self-registration is desired, set the Self Registration option

to Yes.
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Note: Learners can self-register only if the scheduled offering resides in a
catalog that they have access to.
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NASA Business Rule

If self-registration is enabled, an approval process must be selected
and activated.

Also in this section, you configure the minimum and maximum
registrants. If self registration and waitlisting are enabled, learners
attempting to register after the offering is full are prompted to register
with a waitlist status. Administrators are warned but not prevented

from exceeding the maximum registration threshold.

The registration cutoff date and time prevents learners from self-
registering after the date and time has passed. You can still register
learners after this date, but they receive a warning message.
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Lab 5.Setting Registration Parameters

Step

1. Navigate to Learning > Scheduled Offerings.

2. Enter search criteria to search for and locate the scheduled
offering created in Lab 1.

3. Click Search.

4. Click the scheduled offering ID link to access the scheduled

offering in edit mode.
5. Click View All in the core area.

6. Scroll to the bottom of the Additional Settings window to the
Registration section.

7. Setthe Enable Learners to Waitlist option to Yes.
8. Enter a registration cut-off date.

9. Enter a registration cut-off time.

10. Enter the minimum registrations.

11.Enter the maximum registrations.

12.Set the Self Registration option to Yes.

wig  Note: Setting this option to Yes allows learners to register for this
scheduled offering from the learner interface if the item and scheduled
offering are in his/her catalog.

13.Click Save.

i Job Aid: Registration Management
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REGISTERING LEARNERS

Once it is determined that a learner needs to attend a scheduled
offering of an item, the admin has the ability to register him/her for
the offering (Figure 30)

L Related More @ Registration  Add Leamers: |@)|v Settings Advance || B
= Non-enrolled | Waittisted (1) - Enrolled (2) |Total (50) | Open (48) | Stots (0)
atalogs
SesiaAis [Fitesr 4] [ Sort By: Registration | w | [ Fittar for Enrclled Learner Q)

Figure 30: Related Area of Scheduled Offering Record: Registration

Click the Add To Registration Menu button (Figure 31). You may
search for learners using any learner search criteria, or select
learners from the request list for the scheduled item. A request list is
available if the admin enabled learner requests for the item. It is
recommended that you check the request list to see if learners have
requested to be registered for an offering of the item.

Add Learners: | @ v

Add Learners...
Add Learners From Request List...
Add Slots...

Figure 31: Add to Registration Menu Button and Options

When adding learners to the registration of a scheduled offering,
email confirmation checkboxes may be checked in order to notify the
learner, instructor, supervisor, and any contacts listed on the
Contacts tab. Click on the Settings button (Figure 32).
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Send Motifications to:  [¥] Student
¥ Supersor
] Instructar

] Contacts
E-mail Slot Confirmation®to: [ | Organizations

On Learner Removal: [ | Remove the dssociated ltem from Learning Plan

Cancel

Figure 32: Scheduled Offering Settings

The default settings of these checkboxes may be configured globally
in System Admin > Configuration > Registration Settings. These
checkboxes are also available when you withdraw (remove), waitlist,

or cancel a learner from the registration.

Record Attendance

If attendance is recorded for a segment on the Segments tab (as
introduced in Record Attendance on page 40) it will display in the
hover window for the registered learner. Segment Attendance
displays the total segments attended for each enrolled learner based
on the attendance recorded previously on the segments tab. For
example, in Figure 33, the student, Virginia, has attended zero

segments.
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Filker for Enrolled Learner

® VIRGIMIA A CLINGER

Learner ID:  C-vaclinger
K Organization I KSC-BAEOD
- ay| Status:  EMROLLED
Enrolled On:

40192012 06:40 Pa,

AmercalMew York

Segment Attendance: [

& Remowve Learmer

‘™ A

Figure 33: Segment Attendance
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Lab 6.Registering Learners for a Scheduled Offering

Step

1. Navigate to Learning > Scheduled Offerings.

2. Enter search criteria to search for and locate the scheduled

offering created in Lab 1.
3. Click Search.

4. Click the scheduled offering ID link to access the record in edit

mode.
5. Select the Registration tab from the Related area.
6. Click Add To Registration Menu.
7. Select Add Learners from the drop-down menu.

8. Enter search criteria to search for learners to register for the

offering.
9. Click Search.
10.Click the Add checkbox next to each learner you want to register.

11.Check the appropriate Email confirmations to: checkboxes for
those you want to receive confirmation for this offering (these are

at the bottom of the search results page).

Note: It is recommended that you check all boxes. Instructors and
supervisors will get one e-mail notification. Supervisors only receive
subordinates’ names in the e-mail, while instructors receive everyone
registered in the offering.

12.Click Add.

13.View the learners who are registered for the offering. Scroll your

mouse over each learner card to view enrollment details.

i . Job Aid: Registration Management

_“‘%
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WORKING WITHSLOTS

When an organization requests seats in a scheduled offering but
cannot provide the names of the individuals who will attend, the
admin can use the slots feature of SATERN. Slots allow the admin to
reserve seats in a scheduled offering without having to register

specific learners.

Slots are reserved for organizations, enabling only learners who
belong to the organization to self-register in the slot (if self
registration is enabled). If the offering is full, but slots are remaining,
learners who are not a member of the organization may only join the
registration as waitlisted (Figure 34). Admins can register any learner

against a reserved slot.

Add Learners: | @ w

Add Learners...
Add Learners From Request List...

Add Slots...

Add Slots X

Organization ID: Slots: Reservation Date:  Time (himin AMPM): Price Per Slot (1000): Chargeback Account(s):

[ Q[ [3) (e | & (o420 pm ] (.00 i
|

{Eastem Standard Time (Amer vI | 1S Dallar {USD)

Figure 34: Add Slots

Click the Add To Registration Menu button and select Add Slots
from the drop-down menu. Once slots are reserved, the number of
open seats decreases by that number. For example, if there are 15
seats available in the class and the admin reserves three slots, 12

seats remain available for other learners.
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Lab 7.Reserving Slots for a Scheduled Offering

Step

1. Navigate to Learning > Scheduled Offerings.

2. Enter search criteria to search for and locate the scheduled
offering created in Lab 1.

3. Click Search.

4. Click the Scheduled Offering ID link to access the record in edit

mode.
5. Select the Registration tab from the Related area.
6. Click Add To Registration Menu.
7. Select Add Slots from the drop-down menu.
8. Select an organization for which to reserve the slots.
9. Enter the number of slots to be reserved for the organization.
10. Enter the reservation date (defaults to current date).
11.Enter the reservation time (defaults to current time).

12.Click Save.

(1 Job Aid: Registration Management
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REGISTRATION ASSISTANT

The Registration Assistant is a tool that helps streamline the process
of registering learners from the admin side of SATERN. Using the
assistant, administrators may register learners, withdraw learners, or
reserve slots for an organization’s learners. Navigate to Learning >

Tools > Registration Assistant to access the tool.

This tool can be useful for administrators who have the responsibility
of registering learners for offerings but don’t have any setup or
maintenance responsibilities of the offering itself (Figure 35).

=
T a s L om i o

Home  Leanes  Pelomance  Leanane Content  Gommerce  System Admin Refetoners  Reports

Registration Assistant L

Step 1: Select Action

Owecmwisnen Ofmanvasorn @ Reger Loamens

Figure 35: Learning > Tools> Registration Assistant

01 Job Aid: Registration Assistant Tool
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SATERNROSTERS FOR VERIFICATION

A SATERN roster includes the printed name of the employees
registered and provides a place for their signature. This form allows
administrators to clearly see who is registered and who did or did not
sign in for the class. Therefore the following business rule is

recommended.

NASA Business Rule

For scheduled offerings in SATERN, the Center Training Office should
use only SATERN rosters for sign-in and attendance verification, and
should send only SATERN generated rosters to the NSSC for course
close-out process. The NSSC shall only accept SATERN rosters.

CANCELING ASCHEDULED OFFERING

If a scheduled offering that has been created cannot be delivered,
the admin may choose to cancel it. This process allows the admin to
move any learners who are registered with an Enrolled, Waitlisted, or
Pending registration status to the request list for the item. Any
incurred costs associated with the scheduled offering being
cancelled can also be calculated. Cancelled scheduled offerings that
were previously available to learners for self registration are no
longer available. Click Cancel the Scheduled Offering in the
Actions area of the scheduled offering record, or navigate to

Learning > Tools > Cancel Scheduled Offering (Figure 36).
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System for Administration, Training, and Educational Resources for NASA

Learner My Employees

& E W @ #

Home Learners Performance Learning  Content Commerce System Admin

| B ‘ Search: { Enter Keywords or Command ]

Items

Scheduled Offerings
Classes

Group Instances
Catalogs

Curricula
Requirements
Cuestionnaire Surveys
Communities
Instructors

Tasks

(=] Tools

= Step 1 Help

Step 1: Select Scheduled Offering to Cancel

* = Required Fields

Offering:

* Cancellation 4192012

Date:
(MM/DDAYYYY)

Figure 36: Cancel Scheduled Offering Wizard
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Lab 8.Canceling a Scheduled Offering

Step

1. Navigate to Learning > Scheduled Offerings.

2. Enter search criteria to search for and locate the scheduled
offering created in Lab 1.

3. Click Search.

4. Click the scheduled offering ID link to access the record in edit

mode.
5. Inthe Actions area, click Cancel the Scheduled Offering.
6. Leave the default cancellation date and click Next.

7. Click Next without making changes.

wiwig  Note: There are no costs required for this lab.

8. On the Post Cancellation Action Settings page, check the
appropriate checkboxes to add registered learners to the item
request list, send email notifications, and/or inactivate the

scheduled offering.
9. Click Next.

10.0n the Confirmation screen, click Finish.
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LESSON-RELATED REPORTS

The following are reports in SATERN that relate to this lesson:

+ Scheduled Offering Data

The Scheduled Offering Detail report returns detailed information
about each scheduled offering including the item scheduled, dates
scheduled, registration and waitlist data, instructor data, segment
data, and delivery costs.

+ Registration Status

The Registration Status report returns, for offerings and learners
selected a detailed list of registration information including
registration dates and times, enrollment numbers, instructors,
scheduled offering details, and contact information. This report can
be configured to include any of the Registration Statuses (Registered,

Canceled, Waitlisted, and Pending).

¢ Class Roster and Class Roster Verification

These reports return the roster of learners in a scheduled offering.

+ Slot Status

The Slot Status report returns, for organizations and scheduled
offerings, the current status of any slots that have been purchased.
Where learner names have been identified to fill the slots, the learner
names are included in the report, along with registration status and
schedule information. You can group the report by organization or
scheduled offering.
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CONCLUSION

In this lesson, you were introduced to registration concepts for
scheduled offerings. Using the step-by-step instructions, you learned
how to set up the registration parameters, register learners for
scheduled offerings, and use slots to reserve seats for a scheduled

offering. Finally, you learned how to cancel a scheduled offering.

You should now be able to:

+ Define the six registration statuses

+ Set the registration parameters for a scheduled offering
+ Register learners for a scheduled offering

+ Use the Registration Assistant Tool

+ Define and reserve slots for a scheduled offering

+ Cancel a scheduled offering
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LESSON CHECK

Use what you learned in this lesson to answer the following

guestions.

1. True or false:

All of the learner registration options on a scheduled offering are

determined within the Registration tab.

2. What are the registration options available to the admin?

3. True or false:

You can reserve slots for learners who work in a specific job location.
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Activity

Your boss has given you the following task:

+ We forgot to create and register learners for the item X course
that you took last week.

+ Create a scheduled offering for 7 days ago and register yourself
and four other learners.

+ Record the scheduled offering ID.
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Lesson 4: Record Learning Events

After the scheduled offering is complete, you must record learning
events for all the participants. In this lesson, you will learn how to
record learning events. Recording a learning event creates a
Learning History (Completed Work) record for learners and allows
those learners who successfully complete an item to generate a
certificate of completion.

OBJECTIVES

Upon completion this lesson, you will be able to:

+ Define a learning event

+ Record a learning event for a scheduled offering

LEARNING EVENT MAIN CONCEPTS

When you are informed that training has been completed, you can
use Record Learning Event to capture this information. Once the
event is recorded, a Learning History (Completed Work for learners)
record is created that captures the item completed, the date/time it
was completed, and the status the learner was given. If an error is
recorded, you have the ability to edit it with the Learning Event Editor
(if you have been given the appropriate workflow).

A learning event is the record of:

¢+ A completed item

+ An unsuccessful attempt to complete an item

Scheduling Management Page 65



SAT]

+ Arecord of attendance or completion of any external event

—=N

| 1]

considered important enough to document (but not related

directly to learning needs)

Using Record Learning Event, you may choose to record
completions for all learners registered in a selected scheduled
offering. The system does not prevent you from recording
completions for those learners who were never registered. This is
useful for those last minute registrants who were not actually
registered in the scheduled offering but did attend. However, it is
recommended for you to register learners (reconcile the roster) in the
scheduled offering even after the delivery date has passed, for

reporting purposes.

TYPES OF LEARNING EVENTS

There are two types of learning events in SATERN:

+ Item-based events

+ External events

ltem-based Events

Scheduled offerings are instances of items placed on a calendar,
and therefore recording a learning event for a scheduled offering
grants the learner a completion status for the item. The benefit for
recording against scheduled offerings is immediate access to the list
of all learners who were registered in the course, eliminating the

need to search.

External Events

An external event is a learning activity, such as a college course or a

seminar outside of the organization, for which there is no item record
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This external event has a description and comment field to further

identify the nature of the training.

DATARECORDEDIN ALEARNING EVENT

Recording a learning event captures data such as:

+ Learner information

+ ltem title

+ Item status (grade or code)

+ Completion date/time

+ Completion status code (indicates whether or not an item was

successfully completed)

Completion status codes may include, but are not limited to, the
following list:

+ Completed
+ Substituted
+ Incomplete

+ Archived Completed

ACCESS RECORD LEARNING TOOLS

There is one recording tool: Record Learning Event. It is used to

indicate that Learners have completed (or not) a Scheduled Offering.

+ Navigate to Learners > Tools > Record Learning Event (Figure
37).
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Figure 37: Record Learning Event
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Step

1. Navigate to Learners > Tools > Record Learning Event.
2. Click the Scheduled Offering radio button.
3. Click Next

4. Enter the Scheduled Offering ID in the textbox or search for

scheduled offering.
5. Click Next.

6. Fill in all of the required data fields (*). Additional information

such as total hours, or credit hours, can be entered as well.
7. Click Next.

8. To add learners, enter a Learner ID or Click add one or more

from list to search for and select learners.
9. Click Next.

10. Select an option in the Status drop-down menu to adjust a

learner’s status.
11.Optional: Enter comments or grade.
12.Click Next.

13.Click Next.

uunyy  Note: There are no costs associated with this lab

14.1f competencies need to be assessed as a result of recording the
learning event, select the Automatically Assess Related
Competencies checkbox.

15.Review learning event information.

16.Click Finish.
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17.A pop-up may appear requesting that the page refresh before you
proceed. Click OK.

18.The status is displayed.

19.Optional: Click Print to print a completion certificate report for

each learner listed.

20.Optional: Click Email... to email a completion certificate report to

each learner listed.

21.0Optional: Click Start Over... to begin the Learning Event
Recorder process again. This retains all learners previously

selected.
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LEARNING HISTORY

The Learning History tab from the Related area of the learner record
is made up of all learning events that have been recorded, either for
credit or not for credit. You are able to view (but not change or edit) a
learner’s history from the Learning History tab of the learner record
(Figure 38).

Ratated More @ Learning History
Ieam Tiele Seatus Campletion Date Detaly

HASA TRAUDY AWARIHESS TRAIS Subrtitute 127372007
DESCIPLINGY ACCOMMODATIONS! RESPOHDING TO VIOLINT ACTS B THE FIDIRA Completed i
ACOUISITION MTEGRITY PROGRAM ROLLOUT BILING Completed 12532007

IMIGHTS PLATEA SYSTEMS ANIRISL UISERS CONFERENCE Completed BT

INRIHTS 2004 PLATEAU ¥

WAL UPVERS COMFERENCE Completed 10/ 1872008

00T SATERN ADMINISTRATOR SUMMIT Completed STAT

P00 SATERH ADMINISTHATOR SUMAIT Comploted 10F2 2008

Figure 38: Related Area of Learner Record: Learning History

Items with Retraining

Select items within a curriculum that must be repeated on a recurring
interval will have a retraining assignment. Once the item is complete
and recorded (in the learner’s Learning History), it is flagged as
complete and the next required by date it is due according to the
date calculated by the retraining assignment. In this situation, you
will see the item on the Learning Plan tab with the new date for

completion and on the Learning History tab with the date completed.

Certificate of Completion

A learner and his/her training managers can print certificates upon
the learner’s successful completion of an item. Certificates are
generated in .pdf format and open in Acrobat Reader. Certificates
are not generated within SATERN for external events.
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LEARNING EVENT EDITOR

Learning events can be edited and files may be attached to the
record with the Learning Event Editor tool found under the Learners >
Tools menu. Admins with the appropriate workflows have the ability

to edit or delete the learning event records for learners.

An attachment framework is used to provide you with the ability to
attach external documents to records in SATERN. For example, if a
learner completed a course that required a paper-based test at the
end, the paper-based test could be digitized (scanned into a PDF or
MS Word document using other means) and attached to the learning
history record using the Learning Event Editor tool for future

reference.

The attachment interface shows all attachments related to the entity.
In addition, it allows for additions and removals of attachments.
When you click the File Attachments link on the Summary tab of
the record (Figure 39), you can browse for a file to attach to the
record. It is recommended that you enter a description to more easily
identify each file (you cannot modify a description after you upload
the file).
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= Search = Search Results = Edit Summary

User: ERAFAHEY (Fahey, Brian &)
Scheduled Offering: 4025
Item: COURSE HR-101 (Rev 1- 5/1472003 12:00 Ab Americadhew rork)
Item Title: Company Benefits Orientation
Completion Date: 5/1/2011 058:30 PM Armerica/Mew York

Completion Status: CRS-ATHD (Attended Event or Activity)

Financial I User Costs |

Edit the Learning Event

&File Attachments (0)

Instructor ID: @, |

Instructor Name: |

Grade:

Figure 39: Learning Event Record

If you attempt to attach a file that is of an unsupported type, a
validation error displays. If you attempt to attach a file that is larger in
size than allowable, another similar validation error displays. These

limitations are configured by your system administrator.

Learners can access attached files in the learner interface by
reviewing the Learning History details of the recorded item (Figure
40).
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Syatem for Adminisfration, Training, and Educational Resources for NASA
Learner Iy Employees i

Learning History Details

Back
OVERVIEW OF MISHAP INVESTIGATIONS
Course SMA-DD2-07
Revision: 10/6/2010 09:58 AM EST
Scheduled Offering I:
Completion Date: £/11/2012
Status: Completed

Learning History Details

Grade:

Total Hours: 1.50
Credit Hours: C0.00
Contact Hours: 1.5C
CPE Hours: 0.00
Instructor:
Comments:

& File Attachments (1)

Figure 40: Learner-side Learning History > Item Details

Administrators can access the attached files in SATERN from the
Learning History Details page of the learner record (navigate to the
Learning History tab from the Related area of the learner record and
click the View Details link) (Figure 41).
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Item: COURSE SMA-002-07 (Rev 10/6/2010 09:59 AM EST)
Title: OVERVIEW OF MISHAF INVESTIGATIONS
Scheduled Offering
1D:
Instructor:
Completion Date: 4/11/2012 03:05 PM EST

Completion Status: COURSE_COMP (Completed)

Total Hours: 1.50 Contact 1.50
Hours:
CPE Hours: 0.00 Credit Hours: 0.00

Percentage Grade:
Comments:

& File Attachments (0)

Figure 41: Learning History Details: File Attachments Link
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LESSON-RELATED REPORTS

The following are reports in SATERN that relate to this lesson:

+ Learning History

The Learning History report returns learners' learning history
(learning items and curricula they have finished) with detail item

events.

+ Certificate of Completion for Scheduled Offerings

The Certificate of Completion report prints the certificates of
completion for learners from their learning history.

¢ Item Status

The Learner Item Status report returns, for each learner and item,
the learner's completion status for the items they participated in
during the given date range.
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CONCLUSION

In this lesson, you recorded learning events for learners using
Record Learning Event. Using the step-by-step instructions, you

recorded completed items.

You should now be able to:

+ Define a learning event

+ Record a learning event for a scheduled offering

In the next lesson, you will learn about copying scheduled offerings.
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LESSON CHECK

Use what you learned in this lesson to answer the following
guestions.

1. What data can be recorded in a learning event?
Completion date and status

Learner information
Item information

o o T

All of the above

2. True or false:

Admins cannot record learning events for learners who were not
registered in the scheduled offering originally.
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Lesson 5: Copying Scheduled
Offerings
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It can take a long time to set up scheduled offerings one by one.
Copying allows you to copy scheduled offerings and assign resource

to one or more future dates.

OBJECTIVES

Upon completion of this lesson, you will be able to:

+ Describe the scheduled offering copying options

+ Copy a scheduled offering

COPYING ASCHEDULED OFFERING

Sometimes items are scheduled to be delivered multiple times. After
the original scheduled offering is created, the copy feature allows
you to create duplicates, complete with associated resources and
registration parameters. These copies of the original offering can be
scheduled to occur once or repeat according to specific scheduling
rules. These rules include copying multiple times every ‘X’ number of
days, weeks, or months, and can be configured to end after a certain

number of scheduled offerings have been created (Figure 42).
Go to scheduled offering from previous lab.

Click Copy in the Actions area of the scheduled offering record.
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= Company Banefits Orientation a5 I = W@ Actions
Description: B ookmark
Compaery Beesfits Orientation -m B
Cameced e Sohe.
em: COURSE HE- 101 (Roy 50, Approval Process: Clows the Sched,.,
Approval Required: Mo *Domadn:  Human Resswrges (H m.
End Date: £/1/2011 End Tima: 05:30 By | R ———
Facllity: Sin Frmcico C Instructer: Jefirey D Adams

Figure 42: Copy Scheduled Offering

Figure 43 shows available options for creating a single copy of the

scheduled offering.

Copy the Scheduled Offering
* » Requated Fislds
Seheduled Offering ID: 2025

Tile: Company Benefits Cnentation
Start DatefTine: 8712011 0220 AM AmencaMes ok

Options:
7] Copy Group Instance
Copy New Scheduled Citering to the catalog
Use item default segment day numbess
Copy to congecutran Days
® Copy Single Copy Multipla-Daily Based Copy buktiphe-Weakly Based Copy Muitiple-Manthly Bated
* M Start Date: 77 08130 &M Americal Wew Tork

HHRD YY)
*Schedule On: [ Monday [ Tuesday (&) Wednesday & Thursday [ Friday Saturday Sunday
Crvamide adjusted registration cut-off date

Cutoff Date: | Time: Time Tane:

(RO Y YY) {homm AHTH)

Figure 43: Options for ‘Copy Single’

Figure 44 shows available options for creating multiple copies of the

scheduled offering to be held daily.

Scheduling Management Page 81



SAT

—=N

Copy the Scheduled Offering
* = Raquined Fisids
Scheduled Offering ID: 4025
Tithe: Company Benaefits Orientation
Start Date/Time: BA/2011 08230 AM AmencaMew vork

Options:
| Copy Group Instance

] Copy New Scheduled Offering to the catalog
[ Use item default segment day numbers

1 Copy to consecutive Days

Copy Single @& Copy Multiple-Daily Based ) Copy Multiple-Wesakly Based 0 Copy dultiple-Monthly Based

* Mew Start Date: 7] 08:30 AM Americal New Yark
{HMHEIDD A
Scheduls svery wiarking dayiz)
® End after: | schadules
End after: (20|

[¥ Include Registration Cut-off Date

Figure 44: Options for ‘Copy Multiple-Daily Based’

Figure 45 shows available options for creating multiple copies of the
scheduled offering to be held weekly.
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Copy the Scheduled Offering
= » Required Fiekds
Scheduled Offering ID: 4025
Title: Compary Benefits Orientation
Start Date/Time: 8172011 08:30 AM AmericaMew York
Optioms:
7] Copy Group Instance
[7] Copy Mew Scheduled Offering to the catalog
[ Usa itern default sagment day numbers

[7 Copy to consecutive Days

2 Copy Single O Copy Multiple-Daily Based @ Copy Multiple-Weekly Based Copy Multiple-Monthly Based

* Mew Start Date: |7 Q=30 AM Amarical New York
(HMDDAY YY) '
Schedule evary weekis)
@ End after: | schedules
End after: [

[¥] Include Registration Cut-off Date

Figure 45: Options for 'Copy Multiple-Weekly Based'

Figure 46 shows available options for creating multiple copies of the
scheduled offering to be held monthly.

Scheduling Management Page 83



Scheduling Management

SAT

Copy the Scheduled Offering
* » Rguinad Fislds

Scheduled Offering ID: 4025
Tithe: Company Benefits Orientation
Start DatesTinve: 8172011 D830 AM AmericaMew York
Options:
[7] Copy Group instance
] Copy New Scheduled Offering to the catalog
1 Use item default segment day numbars

[7] Copy to consecutive Days
O copy Single ) Copy Multiple-Daiby Based 0 Copy Multiple-Weekhs Based @ Copy Multiple-sonthhy Based

* Mew Start Date: 7)) 08:30 AM America/ New York
(HMDDA YY)

Schedule ww manthis)
9 yse the date as the driver to schedule [e.g. 4th, 23rd, etc.)

Use the day and week as the driver to schedule |e.g. First Widnesday, Last Monday,
1]

@ End after: schedules
End after: (|

[¥] Incluge Registration Cut-off Date

Figure 46: Options for 'Copy Multiple-Monthly Based'
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Lab 10. Copy a Scheduled Offering (Multiple-Weekly Based)
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Step

1. Navigate to Learning > Scheduled Offerings.

2. Enter search criteria to search for and locate the scheduled
offering created in Lab 1.

3. Click Search.

4. Click the scheduled offering ID link to access the record in edit

mode.
5. Click Copy from the Actions area.
6. Select the Copy Multiple—Weekly Based radio button.

7. Enter a new start date in the New Start Date textbox.

wig  Note: Your instructor may direct you to use a date in the past so that one
of your copies may be used in a future lab.

8. Enter 1 in the Schedule every week(s) field.
sy Note: The system schedules a new offering every week.

9. Selectthe End after _ schedules radio button.

10. Enter 2 in this field.

wig  Note: This allows only two new offerings to be scheduled.

11.Check the Include Registration Cut-off Date checkbox.
12.Click Next.

13.0n the Confirmation screen, check the Send Notification
checkbox.
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wiiy  Note: The system sends emails to the contacts listed on the original
| scheduled offering record.

14.Click Copy. Note the new scheduled offering IDs and start dates.
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15.Click Okay
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CONCLUSION

In this lesson, you created copies of a scheduled offering using
different copy methods (e.g., daily, weekly, and monthly).

You should now be able to:

+ Describe the scheduled offering copying options

+ Copy a scheduled offering
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LESSON CHECK

Use what you learned in this lesson to answer the following question.

1. List the different ways you can copy scheduled offerings.
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COURSE SUMMARY

Through lecture, activities, and hands-on computer lab work, this
course taught you the concepts and terminology associated with
scheduling instructor-led items in SATERN. You gained basic,
hands-on experience using SATERN system functions to schedule

items and assign resources.

You should now be able to:

+ Describe the process for creating a scheduled offering

+ Create a scheduled offering

+ Assign resources to a segment within a scheduled offering
+ Reqgister learners for a scheduled offering

+ Reserve slots in a scheduled offering

+ Record learning events

+ Copy scheduled offerings
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This section provides some extra learning-related topics, including:

+ Additional tabs

+ Creating resource records
+ Closing scheduled offerings
+ Working with classes

+ Scheduling curriculum

ADDITIONAL TABS

Additional tabs from the Related area of the scheduled offering
record include:

+ Contacts
+ Materials

+ Notifications
Go to Scheduled Offering from previous lab

Click More to see these additional tabs (Figure 47).
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Contacts >
Related Mure@ >
Materials

Catalogs

Matifications
Segments Cost Calculation
Cost summary
Pricing

Chargeback

Figure 47: Related Area of Scheduled Offering Record: More Tabs

Contacts Tab

The Contacts tab allows you to identify people who should or want to
be notified about registrations for this specific scheduled offering.
Use either an instructor or learner ID. The selected records must
have an e-mail address in the record. When Other is checked on the
Registration tab when modifying the segment information or
registration statuses of learners, all contacts associated to this

scheduled offering receive a notification (Figure 48).

Contacts L2

Contacts

G

Materials Edit the Scheduled Offering

Sections that cannot be edited are not accessible. Access all sections in view mode,

Matifications

Add a Contact to the Scheduled Offering
Cost Calculation

Enter User/instructar D and select Contact Type ar add one or more Users from list or add one or maore instructars from list
Cost Summary
User/Instructor ID Contact Type

Pricing @ Instructor ) User m

Chargeback Update the Contacts for the Scheduled Offering

Figure 48: Scheduled Offering Record: Contacts Tab
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Materials Tab

The Materials tab allows you to assign materials and designate it as
pre or post work for learners or instructors. Material records listed
here are not seen by learners and is not included into scheduled
offering cost (Figure 49). Use of this tab requires a learner to enter a
shipping address when registering if that information is not contained

in his/her learner record.

Materials B

Contacts

Materials > Edit the Scheduled Offering

Sections that cannat be edited are not accessible. Access all sections in wiew mode,

Natifications

Add a Material to the Scheduled Offering
Cost Calculation

EnterMaterial ID ar add ane or mare frorm list

Material ID:
Pricing Type: [Prework [+ m

Chargeback

Cost Summary

Update the Materials for the Scheduled Offering

Figure 49: Materials Tab: Scheduled Offering Record

Notifications Tab

The Notifications tab allows you to create a specific message or
attach a file to registration status emails for this specific scheduled
offering. If the scheduled offering notification is not modified, the item
notification defaults are sent to learners, instructors, supervisors, and

contacts, if these checkboxes are checked (Figure 50).
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Notifications @
Contacts

aterials

Edit the Scheduled Offering

Sections that cannot be edited are not accessible. Access all sections in view mode.

Notifications

| Edit the Scheduled Offering Cancellation Notification for the Scheduled Offering
Cost Calculation |

Cost Surmmary |

i User: |<Iahe| key="notification Schedule Cancellation Student Subject/>

Pricing

Supervisor: |<Iahe| key="notification. Schedule Cancellation. Supervisor Subject" />

Chargeback | - - -
| Instructor: |<iabel key="notification. ScheduleCanceliation. nstructor Subject

Other:

<label key="ndtification Schedule Cancellation Others Subject/>

Body: |<LOOP= -
<lakel key="notiication SchedulsCanpalation MessageText1 /s <aROLLLP_MESG> E
<ILOOP:
<LOOP>
<label key="natification. Schedule Cancelistion. Message Text2" argl="<&ROLLUP_STUD_ID=" arg1="
<SROLLUP STUD_MAME"l> >

</ILOQP>

Figure 50: Notifications Tab: Scheduled Offering Record
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Lab 11. Modify an Offering Notification

Step

1. Select the Notifications tab.

2. Scroll down to the Edit the Registration Notification for the
Scheduled Offering section.

3. In the body of the message, add the following text:
Please bring a Photo ID and notepad to class.

4. Click Apply Changes.
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RESOURCES

You can set up scheduled offering resources in SATERN. Resources
include:

+ Instructors

+ Equipment

+ Equipment Status
+ Equipment Types
+ Materials

+ Facilities

+ Locations

+ Location Types

¢ Custom Resources

Instructors

Instructors can be internal or external to the organization and are not
required to be SATERN LMS Learners or admins. An instructor
record can be associated to a learner record, and vice-versa. When
creating a new instructor, you may select a related learner record to
be tied to the instructor record, and from a learner record, you may
select a related instructor to be tied to the learner (Figure 51).

The instructor’'s email address field is necessary for system-
generated notifications when instructors are added as resources to
scheduled offering segments. In addition, when learners are
registered to take the scheduled offering for which the instructor is a
resource, the instructor can receive email notification of the roster

update.
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» 5earch » $earch Results = Edit Summary

Instructor ID: JEDADAMS

. Mame: Adams, Jeffrey D
Summary >

Custom Fields | Edit the Instructor

Authorized to Teach

* = Required Fields

ek | S
Regions
Last: !Adams
Al | First: |.Jefrrey
WLS Settings . Ml o
Proctaor Status Company: |
Base Cost *Domain: Q, [MFe

Additional Costs Organization: Q, MFS

Figure 51: Instructor Record

The instructor record includes an Authorized to Teach tab, which
lists items the instructor is authorized to teach. When searching for
an instructor to add to a scheduled offering, the search initially filters
for instructors who are authorized to teach the scheduled item. You
can also add authorized instructors on the Item > Instructors tab.
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Lab 12. Create and Authorize an Instructor
Create an Instructor

Step

1. Navigate to Learning > Instructors.

2. Click Add New.

3. Enter an instructor ID.

4. Enter the instructor’s last name, first name, and middle initial.
5. Enter the instructor’s company.

6. Select a domain for the instructor.

7. Select an organization for the instructor.

8. Select a time zone for the instructor from the Time Zone drop-

down menu.

9. Enter an e-mail address for the instructor.

sy Note: Even though this field is optional, it is recommended that you enter
an e-mail address so that the instructor receives all scheduled offering
notifications.

10. Verify that the Active checkbox is checked.
11.Select Related Learner, if applicable.

12.Click Add.

\% Job Aid: Resource Management

Authorize an Instructor to Teach Item

Step
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1. From within the instructor record, select the Authorized to Teach
tab.

2. Click the add one or more from list link.

3. Enter keyword to search for the item(s) you want to add to the

instructor’s authorized list.
4. Click Search.

5. Click the Add checkbox next to all items to be added to the

instructor’s authorized list.
6. Click Add.

7. Verify that all selected items are added to the instructor’s record.
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Equipment

SATERN allows you to manage the use of equipment for learning
activities in your organization. Equipment is any reusable resource
that is used in the delivery of scheduled offerings. Navigate to

References > Physical Resources > Equipment (Figure 52).

0

References

Calendars & Time ¥
COmmerce 3
Compenzation ¥
Geography 3
Learning ¥
Performance 3
Custom Resources Physical Resources b
Equipment System ddmin 3
Equipment Status Uzer anagement b
Equipment Types
Facilities
] Locations

Location Types

wMaterials

Figure 52: References > Physical Resources > Equipment

Examples of equipment include audio components, overhead
projectors, DVD players, computer monitors, etc. Equipment can be
associated with locations and facilities (Figure 53).
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References
Equipment Search | AddMew | &)

= Search » $earch Results = Edit Summary

Equipment ID: AUD1

Description: Audio components

Offerings I Basze Cost I Additional Costs ]

Edit the Equipment

* = Required Fields

Apply Changes @ Copy Equipment...

Description: |.&udi0 components

* Domain: ©, [puBLIC

Serial Mumber:  |aup170017
Equipment Type: | Audio componerts (CD, Tape, AMFM Tuner) (#UD) [=]
Equipment Status: [ in service (INSVC) [+]

Can Be Scheduled: Yes

Assigned Location: | Dallas Classroom 01 (CLASS-DALLAS-01) =]
Facility: | =&
Contact: |Mic:he||e Burroughs
Comments: Aydio components originally in PUBLIC domain.

Apply Changes @ Copy Equipment...

Figure 53: Equipment Record
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Lab 13. Add Equipment

Step

1. Navigate to References > Physical Resources > Equipment.
2. Click the Add New link.

3. Enter equipment ID.

4. Enter a description for the equipment.

5. Select a domain for the equipment.

6. If available, enter a serial number.

7. Select the equipment type from the Equipment Type drop-down

menu.

8. Select the equipment status from the Equipment Status drop-

down menu.

9. Select an assigned location from the Assigned Location drop-

down menu.

10.1f needed, select a facility for the equipment from the Facility

drop-down menu.
11.If needed, enter the contact name.
12.If needed, enter comments.

13.Click Add.

1 Job Aid: Resource Management
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Materials

Materials are the actual consumable supplies needed for the
scheduled offering that are replenished periodically, such as
manuals, handouts, and other non-reusable items that are delivered
along with the other aspects of training. Anything the learner needs
and uses during training or retains after training can be managed as
a material by SATERN Learning.

Materials are referenced in a few different locations:

+ Resources level

— Materials section: Edit default information for materials,

including descriptions.
+ Item level
— Materials tab: Quantity, target, and offset can be specified for
each material.
+ Scheduled Offering level
— Materials tab: The quantities, offset, and target, can be edited
and, if necessary, overridden for each scheduled offering of

the item. Materials on this tab can be identified as pre-
work/post-work.

Scheduling Management Page 103



SAT

—=N

Lab 14. Add Material

Step

1. Navigate to References > Physical Resources > Materials.
2. Click Add New.

3. Enter a material ID.

4. Enter a description for the material.

5. Select a domain for the material.

6. If needed, enter a revision number.

7. If needed, enter comments.

8. Click Add.

[, Job Aid: Resource Management
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Facilities
You can use the Facility section to monitor and manage facilities in
your organization. Facilities are groups of locations. Locations are
places where you can assign things to occur, like scheduled
offerings, equipment, or materials. Use facilities as a way to group
locations together in a method that makes sense to your organization.
For example, a building with many classrooms is a facility. Its
classrooms can be locations. Or, for example, an industrial complex
could be a facility with a training room location, an engineering on-
the-job-training location, and a mock-emergency drill site (Figure 54).

References

Facilities Search | AddNew @

= Search » Search Results = Edit Summary

Facility ID: SF
Description: San Francisco Office

Contact [ Locations [ Equipment ] Base Cost

Edit the Facility

* = Required Fields

Apply Changes @ Copy Facility...

Description: |San Francisca Office

*Domain: @, |PUBLIC

Region: | uest o) [=]
Holiday Profile: | US Federal Holidays (FED) [=]
Time Fone: | Pacific Standard Time (Americallos Angeles) |Z|
Work Week: | Mormal wark week: (NORM) |Z|

External Facility: =

Comments: San Francisco training facility part of original data load (3.26.2003).

Apply Changes @ Copy Facility...

Figure 54: Facility Record
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Regions

Facilities may be associated with regions (geographical areas).
Learners may also have region attributes (Figure 55), and thereby
may search for scheduled offerings local to them (i.e., within their
region) (Figure 56).

Select a Locale and Time Zone

* = Required Fields

* Active Locale ID: /English—|5elect

* Currency ID: | s Dollar (USD)
* Time Zone ID:  America/New York (Eastern Standard Time) - [T Always display Schedule Offerings in this Time Zone

Region ID: | Select

Apply Changes ‘ Reset

Figure 55: Learner-side > Options and Settings Easy Link

Catalog |
Advanced Search
[l curricuta 9] Instructor-Led Online  [¥] Blended Other (] Exact Phrase
7] Search All Languazes

Advanced Catalog Search
| Keywords

#oall Title: [contans |+ |
© only ltems Description: [Contan: || |

D: [Contains [+ |
Subject Area: | Contsins :\ | Select

Source: [contsins [+ || | Select

@ Only Offerings

Facility: i Cantains E” | Select

From: ]
(MM Ay )
To: | | 2

(MAR A Sy )
Show Only Offsrings in my Region
[7] Search All Langusges (Applies to Title, Description, and Subjsct Ares]

Figure 56: Learner-side > Advanced Catalog Search for Local Scheduled
Offerings

Search |

Holiday Profiles

A facility can have designated non-training days (holidays). When
you create a scheduled offering at a certain facility, the system
checks that facility’s Holiday Profile and issues an alert if the

intended scheduled dates include a non-working day (Figure 57).
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| »

i Holiday Profiles Search | AddMew | @
| = tearch » Search Results = View Holidays

Holiday Profile ID: Federal-Holidays-2011

Description: Federal Holidays 2011

l- View the Holidays for the Holiday Profile

.

Holiday [T Description Date
Christmas-Day-2011 Christmas Day 2011 121265201
Columbus-Day-2011 Columbus Day 2011 10/1042011
Independence-Dav- Independence Day 2011 Ti4r201 il
2011

Labor-Day-2011 Labor Day 2011 r52011
Martin-Luther-King- Birthday of Martin Luther King, Jr. 2011 THTR20M

2011

Memoral-Day-2011 Memoral Day 2011 BF305201 ¥

Figure 57: References > Calendars and Time > Holiday Profiles

Work Week Profiles

A Work Week Profile indicates the days of the week training can be
scheduled at a facility. If a facility is selected when scheduling an
item, SATERN skips the days the facility is not available for training
according to the Work Week Profile.

If no Work Week Profile is assigned to a facility, SATERN assumes
the training facility is open for business every day of the week
(Figure 58).
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= Search » Search Results = Edit Summary

Work Week ID: NORM

Summary

Edit the Work Week Profile

Description:

|
g
i

Sunday:

O

Monday:

=

Tuesday:

=

Wednesday:

=

Thursday:

=

Friday:

=

Saturday:

@

Figure 58: References > Calendars and Time > Work Week Profiles
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Lab 15. Create a Facility

Step

1. Navigate to References > Physical Resources > Facilities.
2. Click Add New.

3. Enter a facility ID.

4. Enter a description of the facility.

5. Select a domain for the facility.

6. Select a region from the drop-down menu.

7. Select the Holiday Profile from the drop-down menu.

8. Select the time zone of the facility from the drop-down menu.
9. Select the Work Week Profile from the drop-down menu.

10.Click the External Facility checkbox if the facility is external to

your organization.

11.Enter any relevant comments.
wg  Note: This field is for admin informational purposes only.

12.Click Add.

I Job Aid: Resource Management
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Locations

The location refers to the room where the training takes place. This
record can be identified as internal or external to the organization
and can be associated with a facility (building).

When you create a location resource, you can determine the

maximum capacity for the location (Figure 59).

iy Note: The capacity field does not prevent over-enrolling in a room beyond
its capacity.

References

Locations Search | Add Mew | &)

= Search = Search Results = Edit Summary

Location ID: CLASS-SF-01

Description: San Francisco Classroom 01

m Scheduling I Equipment I Base Cost IAdditionaICosts

Edit the Location

* = Required Fields

Apply Changes E Copy Location...

Description: |San Francizco Classroom 01

*Domaim: @, [puBLIC

Location Type: | Classroom (CLASS) =] &
Facility: | Sah Francizco Office (5F) lz‘ 9
Max Capacity: |50
(1000}
Contact Name:  [Eric wright

Contact Email: |

Comments: San Francisco Classroom 01 part of inftial data losd (19-40g-2003).

Apply Changes @ Copy Location...

Figure 59: References > Physical Resources > Locations
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Lab 16. Create a Location

Step

1. Navigate to References > Physical Resources > Locations.
2. Click Add New.

3. Enter a location ID.

4. Enter a description for the location.

5. Select a domain for the location.

6. Select a location type from the drop-down menu.

7. Select the facility associated with the location from the drop-down

menu.
8. Enter the maximum capacity for the location.
9. Enter a contact name and email for the location

10. Enter any relevant comments.

miig  Note: This field is for admin informational purposes only.

11.Click Add.

1 Job Aid: Resource Management
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Location Types

You can edit and create a location type so that administrators can
associate facilities with the location type (for example, auditorium,
classroom, and science lab) to identify the kind of location that item
training requires.

Custom Resources

Use the Custom Resources section to create and manage resources
that are specific to your organization and not already defined in the
LMS. A custom resource is any resource that you want to track in
your system but does not fit the other kinds of resources such as
materials or instructors. You can add and edit base costs and
additional costs to custom resources.

Related Reports

The following are reports in SATERN that relate to resources:

+ Facility Data

+ Location Data

+ Location Utilization

+ Instructor Data

+ Equipment Data

+ Equipment Status

+ Equipment Utilization
+ Material Data

+ Resource Conflicts

+ Holiday Profile

+ Region Data
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CLOSING ASCHEDULED OFFERING

After the scheduled offering has been delivered, closing the offering
finalizes financial transactions associated with the scheduled offering
and prepares them for the Financial Transactions Approval Process
(covered in the Commerce Basics guide) (Figure 60). Closing an
offering also prevents learners from being added to the registration
list.

Close Scheduled Offering Help
> Step 1

Step 1: Select Scheduled Offering to Close

* = Required Fields

# Scheduled ©, 425
Offering:

+ Closing Date: Oct27/2010

(MMMl YYY )

Figure 60: Close Scheduled Offering
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Lab 17. Closing a Scheduled Offering*

*Scheduled offerings set in the future cannot be closed. For training purposes, the
segments must be entered/changed to past dates to simulate the previous delivery
of the offering.

Step

1. Add a new scheduled offering with a start date in the past. The

system will warn you that you are scheduling in the past.
2. Register learners into the scheduled offering.
3. Click Close the Scheduled Offering from the Actions area.
4. Leave the default closing date and click Next.

5. If there were costs associated with the resources included in the
scheduled offering, you will see those costs calculated. If
necessary, you may modify the incurred costs and click the
Update Total button. For this lab, click Next to bypass the Edit
Realized Costs step without making changes.

6. Click Finish on the Confirmation screen.

sy Note: The Close Scheduled Offering tool can also be accessed by
navigating to Learning > Tools > Close Scheduled Offering.
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SCHEDULING A CURRICULUM

The items in a curriculum can be scheduled all at once using the
Curriculum Scheduling feature. In order to schedule a curriculum, the
items within the curriculum must be sequenced. SATERN places
each item on its own day according to the sequence. Once the
scheduled offerings are created, they can be modified prior to
registering learners by accessing each scheduled offering and
editing the segment information. The new scheduled offerings can be
added to a class, and learners in the class can be registered by

checking the Auto Register checkbox inside the class record.

Sequencing ltems

Prior to scheduling a curriculum, the items must be sequenced from
within the Edit window of the Contents tab of the curriculum record

(Figure 61). You can adjust the sequencing of the content by clicking

the Move Up ( n) or Move Down ( ﬂ) buttons.

Edit

Curriculum: Building Access and Emergency Preparedness

Contents -
Select All /S Deselect All
Display
Entity [T Title Order Elect
OJT HR-003 (Rev 1.2 - 51152004 0317 PM Emergency Evacuation Edi [F
AmeticasMew York ) Proceedures
DOC HR-002 (Rev 1.2 - 57112004 03:16 P Emergency Preparedness = B=1+ I}
AmericaMew York )
DOC HR-001 (Rev 1.2 - 5/11,,2004 03:16 P Building Access Policies and il = ]
AmericaMew York) Proceedures
ge Bt E ! Eeselect all

Figure 61: Learning > Curricula > Contents Tab: Edit Screen
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Associating a Scheduled Curriculum to a Class

During the curriculum scheduling process, you may associate all the
scheduled offerings created for a class. At the end of the process,
you will be able to go to the class record and register learners into
the offerings (Figure 62).

Curriculum Scheduling Help

=5tep 1 = 5tep 2

Step 2: Scheduling Information

Crevon Lot

Scheduling Defaults
* = Required Fields

* Start Date: "
R [ ]

* Start Time: I:

(hmm Add PR

* Time Zone: | Eastern Standard Time (Armericaihen York) lz‘ [T] Show in this Time Zone
* Domain ID: Q W

Instructor ID: Q I:

Location ID: | lz‘ @

Check Resource Conflicts
$end Notification

Scheduling Options
Add the Scheduled Offerings to a Class

Figure 62: Scheduling Curriculum and Adding Offerings to the Class
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Step

1. Navigate to Learning > Tools > Curriculum Scheduling.
2. Search for and select the curriculum to schedule.

Note: The curriculum’s instructor-led items must be sequenced.

3. Click Next.

4. Enter a start date.

5. Enter a start time.

6. Select a domain.

7. Check the Send Notification checkbox.

8. Check the Add the Schedule Offerings to a Class checkbox.
9. Click Next.

10.Search for and select a class ID.

11.Click Next.

12.Verify all information is correct and click Finish.

13.Click Go to Class....

14.Select the Offerings tab.

15.Check the Auto Register checkbox for each offering.

16.Click Apply Changes.
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